
Marshall Islands
Philippines

Federated 
States of 

Micronesia

Nauru
Niue

Palau
India
Sri Lanka

Chile

Ghana

Cook Islands

Rwanda

Unalakleet

Peru

Qatar

Pittsburgh

TECHNOLOGY
IN THE GLOBAL COMMUNITY
CONSULTING

cmu.edu/tcingc

Final Consulting Report
Republic of the Marshall Islands

Banking Commission
Daisy Nkweteyim and Nikolas Rebovich

August 2018



RMI Banking Commission                                                           Page 1 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

Republic of the Marshall Islands 

Banking Commission 

Executive Summary 
Student Consultants: Daisy Nkweteyim and Nikolas Rebovich 

Development Partner: Sultan Korean 

 
I. About the Organization 
 

The Republic of Marshall Islands Banking Commission was established in 2016 to act as 

an independent financial supervisory authority in the Republic to responsible for the 

licensing, regulation and supervision of banks and financial services providers in and from 

the Republic [of the Marshall Islands]1 
  
The Banking Commission reports to the Minister of Finance, the Honorable Brenson Wase, with 

the financial intelligence unit (FIU) acting as the main anti-money laundering (AML) 

enforcement body over financial institutions and cash dealers. The organization is divided into 

three departments, the Financial Intelligence Unit, the Financial Institution Supervision Division, 

and Financial Sector Development. The Banking Commission has 10 employees, overseen by 

the Commissioner of Banking, Sultan Korean. 

 

II. Maintenance of Technology Infrastructure 
Many of the improvements made by TCinGC consultants in 2016 have not been maintained. 

This includes the Banking Commission website, rmifiu.org domain, administration@rmifiu.org 

email certificate, and the FIU database. This was because Matt and the FIU staff did not have 

enough practice using and maintaining these improvements daily.  

 

To improve technology sustainability, Matt Muller has been assigned as the main admin for all 

accounts and is responsible for renewing these accounts when necessary. He has a document that 

has all relevant passwords and renewal dates, so he can manage all of the Banking Commission’s 

accounts. Matt and the FIU staff also have guides for renewal of the email certificate, maintaining 

the database, and modifying the website.  

 

III. Develop Data Modification Skills in the FIU 
In the two years since the FIU database was created it has not been modified at all even though 

changes are necessary to adapt the database to the needs of the FIU. This lack of adjustment is 

because the FIU staff and Matt do not have to requisite skills to make these changes and they are 

afraid of corrupting the database if they make a mistake. To develop modification skills, the FIU 

and Matt were trained to make reports, forms, and tables in Microsoft Access. After the 

consultant is gone they have access to guides that outline how to make these objects. Lastly, a 

practice database was made, it’s an exact copy of the actual database, to allow the FIU staff to 

test modifications without worrying about corrupting the real database. The FIU should utilize 

the practice database to test new objects and adapt the database to their needs by relying on the 

guides made by the consultant.  

                                                
1 shorturl.at/dloHW 

mailto:administration@rmifiu.org
http://shorturl.at/dloHW
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IV. Improve FIU Importation Process 

The original goal of creating a database two years ago was to improve the efficiency of data 

collection and analysis. Unfortunately, the FIU has struggled to import CTRs and SARs because 

of an inability to identify and fix importation errors. The most common problems were 

incorrectly formatted SAR and CTR files. To both improve the number of records imported and 

the time it takes to import one file the FIU and the consultant held a joint test and importation 

training. This will give the FIU staff practice dealing with common errors and the steps necessary 

to import CSV and Excel files. The FIU should continue to practice their importation skills and 

use their guides to troubleshoot any problems in the importation process. 

 

V. Website Development 

In 2016, a website was developed by consultants disseminate information to stakeholders of the 

Banking Commission. However, in 2016, there was hardly any information about the 

Commission.  Additionally, very little legislature had been developed to govern banking 

practices.  Since then, the site has not been updated to reflect the current position of the Banking 

Commission.  The consultant developed and updated the content and structure of the website.  

Matt, the IT specialist was also trained on how to update the website. 

 

VI. The Networking of Departments 

The Banking Commission comprises three departments in four offices located in different 

buildings.  It has two internet lines; one connecting Sultan Korean’s office and the other 

connecting the other three offices.  Early in the consultation process, the consultant was asked 

how departments could communicate with each other, and how staff of the FIU could access and 

work on the database although it was lodged in the manager’s computer.  The consultant carried 

out trainings on file sharing and VPN access with members of the Banking Commission. With 

the trainings, the staff were able to share resources in a secure manner. 

 
 

Consulting Partner       About the Consultants 

Sultan Korean        Daisy Nkweteyim 

skorean@rmibankingcomm.org      dnkweteyim@cmu.edu 

 

RMI Banking Commission      Nik Rebovich 

http://www.rmibankingcomm.org     nrebovic@andrew.cmu.edu 
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Republic of the Marshall Islands 

Banking Commission 

Final Consulting Report 
Student Consultants: Daisy Nkweteyim and Nikolas Rebovich 

Development Partner: Sultan Korean 

 

I. About the Organization 

Organization 

The Republic of Marshall Islands Banking Commission was established in 2016 to act as 

an independent financial supervisory authority in the Republic to responsible for the 

licensing, regulation and supervision of banks and financial services providers in and from 

the Republic [of the Marshall Islands]2 

 

Its office is located in the capital of the Marshall Islands, Majuro. The Banking Commission 

reports to the Minister of Finance, the Honorable Brenson Wase, with the financial intelligence 

unit (FIU) acting as the main anti-money laundering (AML) enforcement body over financial 

institutions and cash dealers. The organization is divided into three departments, the Financial 

Intelligence Unit, the Financial Institution Supervision Division, and Financial Sector 

Development. The Banking Commission has 10 employees total, overseen by the Commissioner 

of Banking, Sultan Korean. 

 

Departments 

The Financial Intelligence Unit (FIU) is the main AML body in the Marshall Islands. Its staff 

consists of Samelda, the manager, and her analyst Sana. The FIU receives monthly Cash 

Transaction Reports (CTRs) and Suspicious Activity Reports (SARs) from the two financial 

institutions in the Marshall Islands, the Bank of Guam (BOG) and the Bank of the Marshall 

Islands (BOMI). This data is imported into an access database that was developed by TCinGC 

consultants in 2016. The FIU then analyzes the data and recommends further investigation on any 

suspicious activity, normally recommending a law enforcement investigation. 

  

The Financial Sector Development (FSD) Unit is headed by Neumi Usumaki. This department’s 

function is to assist the Banking Commissioner in the management of all activities related to 

financial sector development and ensure the effective implementation of key strategies under the 

Financial Sector Development Plan (FSDP) 2016-2020. 3  

  

The Financial Institution Supervision Division (FIS) is led by Rendy Johnny. He is assisted by 

two examiners, one looks at BOMI’s financial data while the other looks at BOG’s. The FIS looks 

at both bank’s stability to ensure they have enough assets/liquidity in the near future to continue 

to do business.         

                                                
2 shorturl.at/dloHW 
  
3 Republic Of The Marshall Islands Office Of The Banking Commission Annual Report 2018. 

http://shorturl.at/dloHW
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Facilities 

 

The Banking Commission has 4 offices on Majuro Atoll, capital of RMI. Souvenir and Matt work 

on the first floor of the Robert Reimer Enterprises (RRE) Hotel building. They have 2 office-

sized rooms and a bathroom. The FIS and FSD work on the second floor of the same building 

with two office sized rooms. The FIU works across the street in a building next to the post office. 

They have two office sized rooms. Sultan’s office is in a housing complex next to the Reimers 

Hotel. He has an apartment style office with a kitchen, bathroom, and a large meeting table. Our 

weekly meetings have been scheduled to hold at the conference room in Sultan’s office.  All 

offices have sufficient light, A/C units, and locks on the doors. The location of these offices is 

different from 2016 mainly because the lease on the previous location was not renewed and the 

whole organization has grown larger in size. 
  

Staff 

 

The Banking Commission has ten personnel in total: 

  

Sultan Korean is the Banking Commissioner. He manages the Office and is the liaison with 

national and international financial entities. Additionally, as he builds the Banking Commission 

staff, he is directly involved in DFIU and FIS intelligence analysis. Currently he uses a desktop 

computer for sending and receiving emails as well as Microsoft Excel for analysis and monitoring. 

  

Rendy Johnny is the FIS Manager. He has a banking and accounting background and oversees 

monitoring banks’ financial data. Currently he receives Regulatory Return Reports monthly in 

paper form and manually enters and tracks them in a Microsoft Excel spreadsheet.  He also 

receives balance sheets, income statements and other financial statements which are useful in 

determining the stability of both the Bank of Guam and the Bank of Marshall Islands.  Like Sultan 

Korean, he mainly uses his computer for email communication and is using Microsoft Office. He 

manages two examiners, Tracy and Sharon, who monitor bank data. 

 

Tracy Oliver is one of the examiners in the FIS.  She works with Rendy to supervise the banks 

and ensure that they are financially performant. 

 

Sharon Ading is the other examiner in the FIS.  She works with Rendy to supervise the banks and 

ensure that they are financially performant. 

  

Samelda Leon is the FIU manager. She analyzes CTRs and SARs and informs Sultan Korean 

about any person of interest through the SAR. 

 

Sana Anien is the FIU analyst. Her main job is to import the CTR and SAR reports into an excel 

document. She will be the main person importing CTRs and SARs into the database. 

  

Mattur (Matt) Muller is the IT specialist for the Office. He oversees all IT related tasks for the 

Banking Commission as well as the database, website, and email maintenance. 
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Souvenir Ned is the administrative assistant for the Banking Commission. He handles the 

financial paperwork for the organization and runs errands for the office. He uses his computer 

mainly for email communication. 

  

Neumi Usumaki oversees the Financial Sector Development (FSD) unit. He develops policy that 

financial institutions follow.  He works with both the FIS and the FIU to ensure that financial 

institutions in the Marshall Islands follow these regulations. 

 

Marlynn Lakabung is the analyst working in the FDS.  She works with Neumi to aid developing 

the financial sector of the Marshall Islands. 
  

Regulations 

 
The Banking Commission gathers the reports sent by the banks, financial institutions, and cash 

dealers, analyzes these reports for possible activities related to money laundering, financial 

terrorism, and off-site surveillance. The reports are as follows: 

  

Cash Transaction Reports (CTRs) 

CTRs are generated for the FIU for all cash deposits and withdrawals of $10,000 or more from 

banks and are utilized by any requesting government officials. The report has total amount of 

money in and out, the date, who made the transaction, and the bank it came through. Law 

enforcement officials may request from the Banking Commission any information, based on the 

reports received, when an investigation is being conducted on people of interest who are suspected 

of money laundering or financial terrorism. 

  

Suspicious Activity Reports (SARs) 

SARs are generated for the FIU when any sort of suspicious financial activity such as a series of 

large transactions or financial transactions that do not make sense for the individual or 

organization. The key elements of the report include the suspect’s personal information, the 

amount of money transacted, the bank it went through, the summary of the type of suspicious 

activity, and the resulting actions against the suspect. 

  

Due Diligence Checks (DDCs) 

DDCs are used to background check companies or individuals that wish to do business in the 

Marshall Islands. The reports are generated when the RMI Office of Commerce and Investment 

requests additional background information on an individual or entity. 

 

Regulatory Return Reports 

Regulatory Return Reports are monthly reports submitted to the FIS on the financial condition 

and performance of financial entities. It allows for the Banking Commission to aggregate data for 

assessing the performance of the economic industry. 
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Communications 

 

Each staff member of the Banking Commission has an office telephone which is frequently used 

to relay information.  They each have an extension number which makes it easy to dial and reach 

a specific person.  This method of communication is used when the callers want quick responses 

usually from a single individual.   

 

The Banking Commission uses emails to communicate with each other.  The emails set up by the 

previous consultants are below: 
administration@rmifiu.org 

Receives the SAR and CTR reports from banks.  

administration@rmibankingcomm.org 

Souvenir uses it as the main administrator for general email correspondence. 

rjohnny@rmibankingcomm.org 

Email account for Rendy Johnny 

skorean@rmibankingcomm.org 

Email account for Sultan Korean 

mmuller@rmibankingcomm.org 

Email account for Matt Muller. He also uses his Gmail account MattMuller22@gmail.com 

sleon@rmifiu.org 

Email account for Samelda Leon 

sanien@rmifiu.org 

Email account for Sana Anien 

  

The office is currently limited to 5 emails on the rimbankingcomm.org domain because Bluehost 

will not allow more addresses. Due to this the examiners do not have work emails and use their 

Gmail accounts for inter-office correspondence.  Those who do have work emails favor using 

personal emails for correspondence.  We should find a way to increase the amount of emails so 

that everyone in the office has one, either through Bluehost or another hosting site. 

 

The Banking Commission also established a WordPress website which is used to relay 

information to the public, potential investors and their stakeholders.  This website contains 

information about the performance of the banking sector, legislation, regulation and relevant news 

items about the Banking Commission. 
  

Technology Infrastructure 

 

There are two internet lines in the Banking Commission.  One that connects Sultan’s office and 

the other that originates from the RRE Hotel and connects the three other offices.  Devices are 

connected on this network.  The database originally was housed on Samelda’s machine.  

Currently, it is found on the server’s (Souvenir’s work computer) public folders so it can be 

accessed by Sana.  The Banking Commission also has a Wordpress website hosted by Bluehost.  

 

The Banking Commission also has telephones which are conceited to each other and have caller 

ID.  Each staff member has a telephone and an extension which they use frequently to relay 

information to one another.  This is the primary means of communication in the Banking 

Commission. 

mailto:sanien@rmifiu.org
http://www.rmibankingcomm.org/
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All computers are using Windows 10 except Samelda. This is because she has an Egmont profile 

on this computer and will have to redo the Egmont profile installation if her machine is changed. 

 

Primary User Hardware 
Specifications 

Software Specifications 

Matt Muller Model: Dell XPS 
CPU: Intel Core i7-6700 
@ 3 GHz 

Windows 10 Home 
Microsoft Office 2016 

Souvenir Ned Model: HP ProDesk 
CPU: AMD A4-6250J 
APU 
@ 2 GHz 

Windows 10 Pro 
Microsoft Office 2016 

Samelda Leon Model: HP ProDesk 
CPU: AMD A4-6250J 
APU 
@ 2 GHz 

Windows 7 Home 
Microsoft Office 2016 

Sana Anien Model: Dell XPS 
CPU: Intel COre i7-6700 
@ 3 GHz 

Windows 10 Home 
Microsoft Office 2016 

 
 

Technology Management 

 

Matt Muller manages the technology infrastructure at the office. He maintains the internet and 

fixes any software or hardware problems. All of this maintenance is done on an ad hoc basis. He 

also is the administrator for staff emails and accounts related to the running of the office. These 

include all the office email accounts, the Banking Commission website, the GoDaddy and 

Bluehost hosting accounts, and the Zoho email account.  
 

Below are the functions of each site: 

 

BlueHost 

Hosts the domain rmibankingcomm.org. This domain has the rmibankingcomm.org emails as 

well as the Banking Commission’s website at rmibankingcomm.org.  

 

GoDaddy 

Hosts the domain rmifiu.org for the Financial Intelligence Unit of the Banking Commission. 

 

 

 

 

Zoho Emails 
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Email hosting for rmifiu.org is done through Zoho. It gives the FIU 10 free emails. Zoho hosts 

the emails for the FIU Unit (Samelda and Sana) as well as administration@rmifiu.org that 

receives CTR and SAR reports from BOG and BOMI. 

 
It should be noted that Matt only became the main account holder for GoDaddy recently and 

was unaware of the account, leading to the account not being renewed in 2017.  In the future he 

will be the main administrator for the website, emails, and domains for the Banking 

Commission. 
 

Information Management 
  
I. Current State 
 

Website 

Information in the Banking Commission is usually communicated using office telephones and 

emails.  Invoices usually arrive the Banking Commission in a paper-based format.  The invoice 

is handed to Souvenir, the administrative assistant who then forwards the invoice to Finance.  

Finance then releases the funds.   

The website currently contains four pages: 

• Home 

• Legislation and Regulation 

• About Us 

• Contact Us 

 

- The Home page contains general information about the Banking Commission and how it 

was formed.   

- The Legislation and Regulation page contains the Banking Act and the Anti-Money 

Laundering Regulation. 

- The About Us page contains information of the Banking Commission as it was in 2016 and 

the roles and responsibility of the Office.  

- The Contact Us page has the telephone number of Sultan, the Commissioner of Banking 

displayed on the page.  Additionally, the form is being sent to Rendy, the Financial 

Institution Supervision Division manager. 

 

Receiving Reports by Secure Email 

The FIU receives monthly Cash Transaction Reports (CTRs) and Suspicious Activity Reports 

(SARs) from the two financial institutions in the Marshall Islands, the Bank of Guam (BOG) 

and the Bank of the Marshall Islands (BOMI). These reports are supposed to be emailed to an 

encrypted email at administration@rmifiu.org, with Samelda Leon being the only user. 

Samelda would then import the files into the database. 

 

Unfortunately, the digital signature in outlook and the GoDaddy hosting domain both expired 

so the office has been unable to receive the reports securely. In that time, BOMI’s data has 

been received in paper form and typed in manually while BOG’s data has been imported by 

CSV file through their encrypted online portal. After Samelda downloads BOG’s files they are 

saved on her computer. Even though it is secure, Sana cannot import BOG’s data because she 

mailto:administration@rmifiu.org
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does not have her own login access. rmifiu.org should be reutilized with a GoDaddy renewal 

and a new certificate to import reports from BOMI. Additionally, Sana should make an account 

in BOG’s portal to access its reports. 
 

Database 

In 2016 student consultants from the TCinGC program made the FIU database in Microsoft 

Access. This database is designed for CTR and SAR reports. The database is currently not 

being used. This is due to various reasons including: 

 

-Importing data causes errors that the FIU staff do not know how to resolve including duplicate 

primary keys, mismatched column names, and data formatted incorrectly. FIU staff do not 

know how to identify the error and fix it. 

 

-The SAR table has too many required fields. If a required field is not filled the data cannot be 

imported. 

 

-With BOMI only sending paper copies the FIU is using their checklist to record reports. This 

checklist is not formatted the same as the database. This makes importing the data from this 

excel file difficult. 

 
 

II. Problems and Solutions 

Website 

The Banking Commission has grown over the last two years and has developed and approved 

of many more legislative pieces and regulation.  The Legislation and Regulation webpage does 

not currently reflect the progress of the Banking Commission and needs to be updated with the 

relevant documentation.  

The About Us page also needs an update with respect to the development of the Banking 

Commission.  It has acquired more employees, more positions and more departments.  Each 

of these departments are engaging in work that will be beneficial to the financial well-being of 

the Marshall Islands.  This evolution needs to be reflected on the website. 

In 2016 when the website was developed, the Banking Commission was a four-man team.  As 

a fledgling organization, it made more sense to have Sultan’s phone number as a point of 

contact.  With the growth of the Banking Commission, they have acquired office telephones 

and hired an administrative assistant who will answer for the Banking Commission. 

 

When the contact form is filled, it is sent to Rendy.  The task of responding to emails and/or 

forwarding emails to relevant avenues is more of an administrative duty.  Therefore, contact 

forms will be sent to Souvenir, the administrative assistant for the Banking Commission. 

 

Database 

The FIU staff are unable to modify or maintain the database for their needs. The database has 

been unmodified since its creation in 2016 because the staff is afraid of breaking it. To fix the 

problems outlined above the FIU staff should have trainings to practice making and modifying 

the database as well as an importation training to identify and rectify importation errors. These 
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trainings should be applied with actual importations and modifications with BOG and BOMI 

reports.  

 

The consultant will also change the formatting of the SAR table so that only the primary keys, 

SAR ID and Social Security number or EIN, are required fields. Frequently the FIU receives 

SARs that do not have data in all the required fields. Removing these requirements will allow 

the FIU to import SAR files that do not have all the data. 

 

The FIU staff also need a printable document for individual SARs or CTRs for the Banking 

Commissioner. Currently Samelda reformats the excel file with the SARs or CTRs into word, 

but it is time consuming and tedious. The consultant will make one report for CTRs and another 

for SARs that are easy to read and reflect the format of the written document. (Appendix S and 

T) 

 

Another problem is the database can only be accessed by Samelda because it is saved on her 

computer as a local file. Sana’s main job is to import the reports, but she cannot do that if she 

doesn’t have access to the database on her computer. The database should be put on the office 

network so both Sana and Samelda can access its records. It will retain its password to ensure 

file security. 

 

Receiving Reports by Secure Email 

 

The Banking Commission must have a more robust system to maintain domain and email 

accounts. Since there was no administrator both the GoDaddy domain account for rmifiu.org 

and the Comodo email certificate for administration@rmifiu.org expired FIU staff were forced 

to use their personal Gmail accounts for work correspondence.   It also led to BOMI to resume 

sending written reports instead of electronically. This forces the FIU to manually type in the 

information; reducing efficiency and time better spent on report analysis. To rectify this, Matt 

Muller will be designated administrator for all domain, email, and website accounts. He will 

also oversee renewing the email certificate for rmifiu.org. He will be given a document will all 

Banking Commission accounts with relevant passwords and renewal dates (Appendix G). 

Since the Comodo certificate renewal process is complex, he will be given a guide and practice 

renewing the Comodo certificate (Appendix I). 
 

Business Systems 

The Banking Commission reports to the Ministry of Finance and is part of the government. As a 

result, all business processes such as accounting and hiring go through them. The Banking 

Commissioner, Sultan Korean, will fill out the necessary paperwork and send it to its proper 

destination. They are currently in the process of establishing their Operational Statement and 

Budget for next year, which must be approved by the Minister of Finance, Honorable Brenson 

Wase. 

  

The Banking Commission must also comply with international standards defined in the financial 

Action Task Force 40 recommendations. These deal with the necessity to collect, analyze and 

disseminate information, and those that deal with international cooperation. 
  

II. Maintenance of Technology Infrastructure 

mailto:administration@rmifiu.org
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Motivation 

Many of the improvements made by TCinGC consultants in 2016 have not been maintained. This 

includes the Banking Commission website, rmifiu.org domain, administration@rmifiu.org email 

certificate, and the FIU database. This was because Matt and the FIU staff did not have enough 

practice using these improvements daily. They also lacked the skills to adapt the technology 

infrastructure to the organization’s needs.  

 

To improve technology sustainability, Matt Muller has been assigned as the main admin for all 

accounts and is responsible for renewing these accounts when necessary. He has a document that 

has all relevant passwords and renewal dates so he can manage all of the Banking Commission’s 

accounts (Appendix G).  

 

The main objective of the website is to disseminate information about the Banking Commission 

to its stakeholders.  These include international bodies such as the IMF and the world bank and 

domestic institutions such as the various banks in the Marshall Islands.  Currently the WordPress 

website is bare and hasn’t been updated since the last consultants left in 2016.  More recent 

content has to be uploaded to the site and the UX design needs some improvement.  The 

WordPress website is currently hosted by Bluehost. 

 

Outcomes 

The FIU can securely import SARs and CTRs electronically through the rmifiu.org email. This 

process is be more efficient than typing in each record and will allow them to spend more time 

on analyzing the reports. Both Sana and Samelda have access to administration@rmifiu.org and 

the database. Matt has also practiced renewing and installing the Comodo certificate necessary 

for BOMI to securely send the FIU an electronic copy of their reports. 

 

Activities:  

-Renew GoDaddy domain at rmifiu.org and renew Comodo certification for digital signature  

-Import SARs and CTRs from banks through rmifiu.org 

-Give Matt Muller administrative access to all electronic Banking Commission accounts and a 

document with all account and renewal information  

-Put backend database on the network 

-Work extensively with Matt to ensure he can put up appropriate content for the website whenever 

the need arises. 

-Wrote documentation and guides to aid in the process of maintaining technology infrastructure. 

 

Output: 

-Banking Commission Account and Renewal Document (Appendix G) 

-Certificate renewal and installation guide (Appendix I) 

-How to Link Backend Tables to Frontend Database (Appendix N) 

-A web administrator who will be able to update content of the site. 

 

 

Recommendations 

Matt Muller should be the main manager for all technology account information. He should keep 

the account/renewal document up to date and alert Sultan Korean to any impending renewals. 

mailto:administration@rmifiu.org
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Since the Banking Commission does not have a standardized process to pay for services over the 

internet, Sultan must be notified with enough time to figure out a way to pay. Matt will also be 

the main person to renew the Comodo email certificate for the FIU and move the FIU database if 

necessary. He should refer to the guides made by the consultant to illustrate how to perform these 

tasks. 

 

III. Develop Data Modification Skills in the FIU 

Motivation 

In the two years since the FIU database was created it has not been modified at all even though 

changes are necessary to adapt the database to the needs of the FIU. This lack of adjustment is 

because the FIU staff and Matt do not have to requisite skills to make these changes and they are 

afraid of corrupting the database if they make a mistake. To develop modification skills, the FIU 

and Matt were trained to make reports, forms, and tables in Microsoft Access. After the consultant 

is gone they have access to guides that outline how to make these objects. Lastly, a practice 

database was made, it’s an exact copy of the actual database, to allow the FIU staff to test 

modifications without worrying about corrupting the real database. 

  

Outcomes  

Activities 

-Hold Database modification tutorial 

-Sana, Samelda, and Matt make CTR and SAR table, form, and report 

-Standard Operating Procedure for Modifying FIU Database 

-CTR and SAR Printable Reports (Appendix S and T) 

-Due Diligence Table and Report (Appendix H) 

-Make copy of Database for Practice Database 

 

Guides 

-How to make a table in Access 2016 (Appendix J) 

-How to make a form in Access 2016 (Appendix K) 

-How to make a report in Access 2016 (Appendix L) 

-New Table from Data in Access (Appendix M) 

-How to Import from a Database (Appendix O) 

-Standard Operating Procedure to Modify FIU Database (Appendix U) 

  

Trainings and Output 

A database modification tutorial was held in week 4 to show Sana, Samelda, and Matt how to 

create a simple table, form, and report in Microsoft Access 2016. They followed Nik’s 

instructions step by step, along with their written guide, to make the three objects. All three staff 

members were able to make a table, form, and report. 

The second training required Sana, Samelda, and Matt make a CTR table, form, and report in 

addition to a SAR table form and report. They used the guides “How to Make a Table”, “How to 

Make a Form”, and “How to Make a Report” to assist them if they had any problems. This gave 

them experience making these objects without the help of a tutorial or relying directly on the 

consultant. They also became familiar with the structure of the database. This will allow them to 

adapt the database to their future needs. Each staff member was able to make the six objects 

required in the training. In addition, Sana made a table and report for Due Diligence Checks 
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(DDCs). The DDC is a new form for the FIU to record background checks on individuals and 

business entities. This allowed her to practice the skills she learned in training on a real object she 

created on her own. 

Recommendations 

Since the FIU is mostly utilized as a data repository for CTRs and SARs data modification is not 

a common occurrence. Since these skills will not be habitual, the FIU must rely on the data 

modification guides to create or change objects in the database. These guides are located in the 

public folder on Samelda’s and Souvenir’s computers. The consultant also has copies of the 

guides if they are lost. 

 

When modifying the database the FIU should consult the Standard Operating Procedure for 

Modifying FIU Database. This document outlines making an object in the practice database first 

(this database is an exact copy of the database without CTR and SAR records). This will ensure 

the object works correctly in the practice database before it is made in the actual database. This 

will prevent the database becoming corrupted and inoperable. It also gives FIU staff the ability to 

practice their modification skills without worrying about losing important data. 

  

IV. Improve FIU Importation Process 

Motivation 

The TCinGC consultants developed an access database in 2016 for the importation of SARs and 

CTRs to improve the efficiency of data importation and analysis. Along with the email problems 

stated in the organization section, the office has also struggled to import incorrectly formatted 

data into the database. This includes mismatching column names, repeating primary keys, and 

field formatting issues. These problems are easily fixable for someone who has experience dealing 

with dirty data. These problems are also taking time away from the more important task of 

analyzing reports. The FIU staff, Samelda and Sana, were trained and tested to identify and fix 

data importation problems so they can spend more time on analysis. Matt Muller should also be 

a participant in these trainings as backup support in case the FIU staff cannot solve the problem. 

 

Outcomes 

Activities 

-Administer Importation test for FIU staff in week 6 for baseline and week 10 for measurement. 

-Make guide to identify and fix importation errors (Appendix P) 

-Make How to Import a CSV file into Access (Appendix Q) 

-Make How to Import an Excel file into Access (Appendix R) 

  

Importation Test 

A guide was made for the FIU to identify importation errors and indicate how to fix the error (if 

the FIU had to fix it or the bank). Sana and Samelda used this guide to help them through the 

baseline importation test in week 6 and the final test in week 10. This test has five CTR practice 

files which each have an error. FIU staff had to first attempt to import the file, read the error 

message after the importation was unsuccessful, identify the error, fix the error, and finally 

successfully import the file into the database. 
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Based on these tests Sana and Samelda were able to identify 3 out of 3 importation errors 

(mismatching field names, duplicate primary keys, and incorrectly formatted data). This is an 

improvement from before when Sana and Samelda were unable to identify any of these errors. 

They would automatically call Matt Muller, but he was unable to fix the errors either. This led to 

the FIU staff not using the database and reverting to typing in reports manually into an excel 

spreadsheet. Now the FIU staff is trained to deal with these common errors they will be able to 

consistently import CTR and SAR reports, saving them time. 

  

Measurements 

In terms of time the FIU decreased data importation by 92% compared to receiving the report in 

a paper format and typing it in manually. It takes Sana 4 minutes to import a CSV CTR file into 

the database if there is an error in the file. It takes Sana 4 minutes to manually type in one CTR 

record into the database. The FIU receives an average of 6 CTRs per work day. Therefore 24-4= 

20 minutes saved per day. 20/24= 83% time saved per day by importing a CSV file instead of 

manually typing every BOMI CTR. 

  

The FIU is in the process of importing all reports securely from the rmifiu.org email into the 

database. They have imported 117 CTR reports and 206 Person in Transaction Reports. This is 

roughly how many records were imported before the start of the consultation in 2018. 3% 

importation of reports from rmifiu.org into the database (100 CTR records were imported to the 

database between 2016 and 2017 while the database was operating out of a total of 3200 CTR 

records in total). 

   

Based on the importation test both Sana and Samelda decreased the time it takes them to identify 

and correct an importation error. In week 7 it took Sana 20 minutes to identify and correct 5 

importation errors. In week 10 it took her 11 and a half minutes with similar errors. This represents 

a 43% improvement in efficiency. Samelda also showed improvement going from 14 minutes in 

week 7 to 11 minutes in week 10. This is a 21% improvement in efficiency. During both tests at 

least 90% of the test was completed without outside help from the consultant. 

   

Recommendations 

The FIU must consistently import files to practice the skills they have learned. Continual 

reinforcement of the training skills will solidify the FIU’s ability to identify and correct formatting 

issues. This practice will also improve the efficiency of the importation process over time leading 

to very little time used to import files.  

 

The FIU must identify and correct bank formatting errors. BOG and BOMI have column names 

that are misspelled or do not match up with the column names in the database. While these are 

easy to fix, importation will go quicker if the banks are notified of these problems and fixed. This 

will allow the FIU to import CTR and SAR files with less time devoted to fixing errors. 

 

The FIU must make sure BOMI send them electronic records. Currently BOMI is still sending 

CTRs and SARs in paper format. The Banking Commission must ensure BOMI starts sending 

electronic copies of the reports as soon as possible. This will reduce the amount of time Sana 

spends importing files and will reduce the amount of time BOMI spends writing the reports. 
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V. Website Development 

Motivation 

The Banking Commission in the Marshall Islands is one of the key parts of government.  In 2016, 

a website was developed by consultants to disseminate information to stakeholders of the Banking 

Commission.  However, in 2016, there was hardly any information about the Banking 

Commission.  Additionally, very little legislature had been developed to govern banking 

practices. 

Matt, the IT technician who would have maintained this website was hired approximately two 

weeks before the consultants left.   In his new role, he did not acquire skills needed to maintain 

the site.  He therefore, was not overtly involved in the development of the website and could not 

effectively maintain it.  This was the main reason the site had not been maintained when the 

content did eventually become available.  

The Banking Commission website is to serve as a communication tool between the Banking 

Commission and its stakeholders.  Some of the Banking Commission’s stakeholders is the IMF, 

the World Bank, the Asia/Pacific Working Group on Money Laundering, international and 

domestic banks and shareholders.  As such, it is imperative that the website contains relevant 

information that would be useful to these stakeholders and the public.  

Outcomes 

The first thing the consultant did was to discuss with staff of the Banking Commission and gain 

their perspective of content that they would like to have on the website.  The consultant offered 

different ideas with respect to the kind of content that would be relevant to the Banking 

Commission.  With an idea of what content would be included on the website, a model was 

developed. During the weekly executive meetings, the consultant demonstrated how these 

wireframes would form the blueprint of the website (see Appendix A).  The wireframes were then 

reviewed, and more suggestions were made based on the blueprint. 

The webpages that formed the base of the existing website were modified to reflect the current 

position of the Banking Commission.  These webpages are: 

·         Home        

·         About Us 

·         Legislation and Regulation 

·         Contact Us 

There were a couple of webpages added from the existing base.  These webpages are: 

·         Annual Reports 

·         Bank Data 

·         Relevant Links 

·         Gallery 

·         Bios 
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·         FAQ 

·         News and Events 

Improvements 

The Home and About Us pages were modified to reflect the current position of the Banking 

Commission.  The About Us page was modified to include information about all the departments 

in the Banking Commission that had been formed since 2016.  The Legislation and Regulation 

page was improved with updated content.  In 2016, there were two pieces of legislature on the 

site; the Banking Act and the Anti-Money Laundering Regulation.  Since then, more legislature 

has been developed. The consultant included content related to directives, guidelines and reports. 

The Contact Us page was modified to include a reCAPTCHA to prevent spam.  In 2016, when 

the website was developed for the first time, it was a four-man team consisting of Sultan, Samelda, 

Rendy and Matt.  As a fledgling organization, it was more sensible to have Sultan’s phone number 

displayed for a telephone number.  However, with the expansion of the Banking Commission, an 

office telephone was acquired which was then used as the telephone contact.  Additionally, the 

consultant changed the recipient of the contact form to the Banking Commission administrative 

assistant, Souvenir who had not yet been hired when the website was first created.  When Souvenir 

receives emails through the contact form, either he answers inquiries or redirects emails to the 

relevant avenues for a response. 

Additions 

• The FAQ page was an addition that featured questions and answers such as: ‘How to 

acquire a banking license?’ and ‘How to report suspicious activity?’. 

• The gallery page contained gallery photos organized in groups of workshops, seminars 

and programs. 

• Bank Data was also a new addition.  The bank data webpage consists of quarterly reports 

of consolidated bank data of Bank of Marshall Islands and Bank of Guam.  Due to the 

sensitivity of the data, it is important that approval is gotten from Sultan before adding the 

data to the website as content. 

• The Annual Reports page contains the annual reports of the progress of the Banking 

Commission. 

• The Bios page contains information of the managers of the Banking Commission and 

Sultan and the work they do. 

• The Relevant Links page contains information about the various stakeholders of the 

Banking Commission.  

• The News and Events page contains information about the news items and press releases 

of the Banking Commission. 

• The website theme was also changed to one with responsive design to cater to all devices 

and to improve user experience. 

To ensure that the website is maintained while I’m gone, the consultant worked extensively with 

Matt, the IT technician and included him in many of the discussions throughout the development 

of the wireframes and website itself.  He was instructed on how to create new web pages and how 

to include different types of content to the website (see Appendix B).  Before departure from the 

Marshall Islands, a list of tasks was created for him to carry out to further improve technical skill 

and know-how required to maintain the website and keep it updated which he started.   
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Recommendations 

The consultant recommends that the website be updated at least once a quarter.  Three months 

will provide enough material to be acquired that could be added to the website.  Consolidated 

bank data records are compiled on a quarterly basis and is imperative for potential investors to be 

kept up to date with the financial performance of the Marshall Islands’ banking sector.  Once a 

quarter should be the longest period gone without an update to the website.  With every news or 

press released, the website ideally, should be updated with the relevant press. 

  

VI. The Networking of Departments 

Motivation 

On the first few days of working with the Banking Commission, Matt, the IT technician asked 

me a question.  For context: Samelda, the FIU manager has the database on her machine.  Sana 

would be working with her.  However, Sana does not have access to the database because it was 

stored on Samelda’s machine.  Was it possible for Sana to access work on the database on 

Samelda’s work computer?   

During the first two weeks of requirements gathering, some departmental staff had mentioned the 

fact that they wanted to be able to share files with each other without having to waste time 

transferring these files with a flash drive.  It was also stated that it would be better if these folders 

are kept in a central store so that they can be accessed between departments when necessary. 

These two instances were related.  How can information be shared between and across 

departments?   

The Banking Commission has 4 separate offices.  In this configuration, there are two internet 

lines; one connecting the Banking Commission office, the FIS/FSD and extends to the FIU and 

the other connecting Sultan’s office. 

It was apparent that the Banking Commission needed a means to communicate with each other.  

In addition to this, the Banking Commission had some problems connecting some printers.  There 

were some printers that would disconnect and would not reconnect themselves again whenever 

the router in the Banking Commission main office was rebooted.  

Outcomes 

The consultant initially created a document where files could be shared between members of the 

FIS.  However, after review of the document and from relevant feedback, a central store was 

proposed to store all documents from the departments.  With this feedback, I developed another 

document (see Appendix C).  Souvenir’s machine was designated as a server where files would 

be stored.  There were folders designated to hold material for the FIS, FSD and FIU.  As a result 

of these configurations, Sana, the FIU analyst can now access the database on her work computer 

instead of using Samelda’s, the FIU manager in a time efficient manner.  Before the 

configurations, it took on average three minutes and eighteen seconds for files to be transferred 

using a flash drive as opposed one minute and two seconds to access that file on the network.  

This saved two minutes and sixteen seconds on average which could then be used for other tasks. 

The routers in the Banking Commission office, FSD/FIS and FIU were configured to act as 

wireless repeaters.  Their DHCP applications were turned off and their IP addresses were 

delivered by the main router in the Banking Commission office.  With the main router at the 



RMI Banking Commission                                                           Page 18 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

Banking Commission, handing out IP addresses and the routers in the other offices being statically 

enabled, printing problems had ceased. 

When the consultant first arrived, Samelda, the FIU manager was off island for a work function.  

During some point in our stay in the Marshall Islands, each of the managers and Sultan were not 

in office either because they were off island on mission or because they had taken their leave of 

absence.  During this time, they could not access files which they had been working on while in 

office.  Therefore, the Banking Commission router was configured to accept VPN connections 

from the managers and Sultan (see Appendix D).  For clients to access the network, see Appendix 

E 

Recommendations 

Files must be backed up at once a week in preparation of system failure. The consultant 

recommends following the standard operating procedure for backing up the files on server (see 

Appendix F).  If the server crashes, then those files are lost.  However, with a backup, files can 

be saved and retrieved if there ever is a system failure.  This will save time in reproducing the 

documents if the server crashes. 

  

VII. Additional Recommendations 

Design a Seal for the Banking Commission 

The Banking Commission and many other government organizations in the Republic of the 

Marshall Islands do not have an official seal to identify their branch of government.  The 

consultant recommends a seal be designed for official use by the Banking Commission. 

Acquiring an SSL Certificate for the Website 

Additionally, the consultant recommends acquiring an SSL certificate for the website.  

Certificates are used in websites to ensure secure connections between web browsers and servers.  

The Contact page of the website contains fields which can be filled by a user.  An SSL certificate 

can prevent hackers from acquiring the information input in those fields.  Additionally, secure 

websites given high rankings in search results which makes it easier to find on the web. 

• SSL certificates can be purchased from platforms and hosting services such as GoDaddy.  

• Comodo provides free certificates valid for ninety days. 

 

 

 

About the Consultants 
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Appendix A: Wireframes 

 

 
The Home page 
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The About Us page 
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The News page 
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The Events Page 
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The Frequently Asked Questions page 
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The Contact Us page 

 

 

 

 

 

 

 

 

 

 

 

 

 



RMI Banking Commission                                                           Page 27 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

The Legislation page 
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The Bank Data page 
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The Future Plans page 
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The Gallery page 
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The Annual Reports Page 
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The Bio page 
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Appendix B: Website Development Tutorial 

 

The WordPress website dashboard contains several icons that aid in website development.  They 

include: 

Media: This tab contains a library of media items used on the website such as images and forms.  

More media items such as audio can be added through the media tab unto the website. 

Pages: This tab houses the web pages of the website.  There are currently 21 published webpages. 

Appearance: This tab is responsible for the theme’s look and feel.   

Plugins: Plugins are external software that can be plugged into the site to increase functionality.  

The site has 14 active plugins which include the Photo Gallery Plugin, AWSM Team plugin and 

Contact Form 7 plugin.  These all aid to increase the site’s functionality. 

To add pages to the site: 

1. Go to Pages 

2. Click ‘Add New’ 

3. Add Content 

a. This can include media files and gallery photos.  Also, allowance is made for text 

modification.  It is important to keep the end-user experience when creating a page 

4. Click Publish. 

After clicking on publish, these pages exist with a designated URL, however, there is no way for 

the end user to access these pages.  To be accessed by the end user, pages can be added as menu 

items to the webpage. 

To add pages as menu items to a webpage: 

1. Go to Appearance. 

2. Click on Menu. 

3. Select a menu to edit (or create a new one) 

4. Then mark the checkbox of the pages to add to the specified menu and click ‘Add to Menu’ 

5. Organize the menu structure to reflect the order in which the menu items appear. 

6. Determine the display location of the menu either at the top or at the footer. 

7. Click ‘Save Menu’. 

Widgets   

An important aspect of the Appearance tab is the widget.  Widgets provide and interface for an 

end-user to access a service.  Widgets includes audio players, calendar of events and even a photo 

gallery slideshow.  They can also be navigational menus. 

Although a page has been created and added to a menu, the end-user will only be able to access 

that menu if it is seen on the page.  Therefore, the menu can be included to the navigation menu 

widget.  In the Banking Commission website, the menu is found on the left sidebar.  

 

Plugins 

Plugins provide increased functionality for a WordPress website.  Some plugins which are worthy 

of note are: 
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The Photo Gallery plugin:  It provides functionality for the Gallery webpage.  The Alt/Title 

provides a summary of the photo.  Alt/Titles are indexed by search engines and provide the text for 

photos.  The description is a more in-depth summary of the photo.  This plugin provides short code 

that can be added to the webpage. 

The AWSM Team plugin: This plugin provides functionality for the Bios webpage.  Teams and 

members of each team can be added along with their designation.  Presets and Styles are chosen 

for each team and translated into short code for use on the webpage. 

Contact Form 7: This plugin provides functionality for the Contact Us Page.  It includes the 

name, email, subject and message and other form tags that provide information about the sender.  

The mail from the contact form is configured to be sent to administration@rmibankingcomm.org, 

which is for Souvenir, the administrative assistant. 

Yoast SEO (Search Engine Optimization): This plugin improves the webpages to be better 

indexing and optimization by search engines.  It provides functionality such as on-page content 

analysis and XML sitemaps. 

Statistics: This plugin provides site analytics and statistics.  It provides information about the 

users accessing the site (browsers, referring sites).  Other information provided include the number 

of visitors, the number of visits of each page, the top 5-page trending stats. 

With the addition of more and new types of content, more plugins can be installed to handle the 

increased functionality. 
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RMI Banking Commission                                                           Page 35 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

Appendix C: File Sharing Over a Network 
 

Sharing Files Over a Network  
This tutorial serves as a guide for sharing files and folders securely over the same network.  This is for 

Windows 10, although the tutorial can be adapted for other versions of Windows.  

  

1. First make sure all devices to be shared are on the same network.  

 
2. Second, you want to make sure that your computer can be discoverable on the network when sharing 

files.  To do this,  

a. Click on the Windows icon on the taskbar and type ‘Settings’. Select Settings. 
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b. Then select ‘Network & Internet’ 

 

 

.   

c. Click on ‘Sharing options’ 

 
 

 

 

d. There are two network profiles available: Private (which is the current profile for the RMI-BC-Wifi 

network) and Public.  Private networks are those in places like your homes and public networks are those in 

public places like restaurants.  You don’t usually want your devices to be discoverable on public networks. 
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e. We are not currently on a public network, therefore under ‘Guest or Public’ make sure to click on ‘Turn 

off network discovery’. 
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f. All networks include both public and private networks.  For file sharing, it is important to ‘Turn on 

sharing so anyone with network access can read and write files in the Public folders’. 

 
 

 

g. Click on ‘Save changes’ and restart your device for the changes to take effect 

3. Now, your devices are discoverable on the same network.  Put those files you intend to share in the 

Public folders of the server (ADMINISTRATION).  This is found in Network -> ADMINISTRATION  -> 

Users -> Public -> Public Documents 
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4. Password Protect Files 

For example, in excel.  Click on File -> Info -> Protect Workbook -> Encrypt with Password.  

 
In Word, click on File -> Info -> Protect Document-> Encrypt with Password.  

 
5. You will be asked to enter and confirm a password.  Remember this password because once lost, 

Microsoft cannot recover this password for you.  You could keep an updated unencrypted version of this 

file, just in case.  

6. Finally, share your password to only those you wish to have access to your file.  

 

Your files can now be accessed by those in your network.  

 

7. To access files on the network, go to Network -> ADMINISTRATION  -> Users -> Public -> Public 

Documents 
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If you cannot find ADMINISTRATION, then type file://ADMINISTRATION in the address bar.  Input the 

password to that file to access it. 

Warning:  As mentioned above, it is important to remember the password you encrypted your files with.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

file://///ADMINISTRATION


RMI Banking Commission                                                           Page 41 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

Appendix D: VPN Connections 

 

VPN Connections with a Netgear (Server) Router 

Important Notes 

1. A VPN (virtual private network) connection is a secure connection to another network 

through the internet.   

2. All devices have one unique IP address which is private.  The only exception to that is the 

router.  The router has two IP addresses.  One address is public.  The other is private. 

3. The public IP address interfaces with the WAN while the private IP address interfaces with 

the other devices in the LAN. 

4. While carrying out VPN connections between 2 devices on different networks, connections 

are made between the routers of the two networks through their public IP addresses. 

5. The public IP address is distributed by the Internet Service Provider (ISP), which in the case 

is NTA (National Telecommunications Authority).  Every time, the router reboots a new 

public IP address is assigned to the router.   

6. For VPN connections to be successful, the router will need to know the public IP of the other 

router to know which network it has to connect to.  This cannot happen if ISPs keep assigning 

IP addresses.  Therefore, it is important that the public IP address is kept static or Dynamic 

DNS is enabled so that each client machine that wants to connect to the network can easily 

do so without having to worry which IP address to connect to. 

Step 1: Configure the router receiving the connection to have either a static IP or enable 

Dynamic DNS 

 

Step 2: On a Netgear router, go to Advanced VPN settings and follow the steps. You need 

administrator privileges. 
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Appendix E: Access with a VPN 
 

Access with a VPN 

The following guide demonstrates access with a VPN by client machines. 

1. Determine system type of laptop that will be used to access the network through a VPN. 
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2. Go to Network -> ADMINISTRATION -> Users -> Public -> Public Documents -> 

General and install the VPN client.  (If system type is 64-bit, then install VPN - 64bit.  If 

system type is 32-bit, then install VPN - 32bit) 

 
3. Copy the configuration files to another location and unzip them.  Configuration files are 

found in Network -> ADMINISTRATION -> Users -> Public -> Public Documents -> 

General.  (That is, windows.zip for windows computers and nonwindows.zip for 

nonwindononwindows computers.) 

 

 

4. Copy the contents of the unzipped folder and paste them into the folder that the VPN client 

is installed.  Usually found at C:\Program files\OpenVPN\config\ 
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5. In Windows, you need to modify the VPN interface name to "NETGEAR-VPN". The VPN 

interface usually has a Device Name as "TAP-Windows Adapter". 

 

 
 

6. Run client as Administrator while on a different network (internet connection) 

  
 

Modify name to NERTGEAR-VPN as shown 

below 
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You will now be able to access files on the banking commission network. 

7. Disconnect VPN by clicking Disconnect. 
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Appendix F: SOP for Backup of Network Files 

 

Standard Operating Procedure for File Backup 

All files are currently hosted on ADMINISTRATION, therefore if that computer crashes, then all 

files will be lost.  Therefore, it is important to backup files on the network. 

  

When Does Backup Take Place? 

All backups for departments should be carried out on Friday, at the end of the work week.  

In the event where Friday is a public holiday or otherwise not a convenient day to carry out backups, 

the preceding day should be designated as the backup day.  For example, if the backups cannot be 

carried out on a Friday, then the backups should be carried out the day before, a Thursday.  

Who Does Backup of Files? 

Backups should be carried out by managers of the various departments.  Each manager should back 

up his/her departmental folder on the network.   It is important to ensure that the external storage 

device can only be accessed by the manager of the various divisions. 

Steps in Backing Up Files 

1. At the end of the working day, ensure that all computers have closed access to files. 

2. Using an external storage device, backup files by copying and pasting the respective 

departmental folders to the storage device. 

3. Replace all files with updated versions. 

4. Keep the external storage device safely. 
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Appendix G: Banking Commission Account and Renewal 

Document 
 

1. Sign in to www.wordpress.com with login 

Username: osa@andrew.cmu.edu 

Password: SultanRendy4bc 

 
2. Click “My Site” on the top left corner, once it takes you to the next page then click 

“Banking Commission” on the top left corner to see the site. 

 
You are now in edit mode 

 

3. At the menu at the top, click the tab to go to the page you want to edit. If you would like to 

edit the text, go to the bottom of the text and click edit. The page that opens up allows you 

to change the text. Once finished make sure to click “Update” on the top left side. 

 
To add pdf:  

1. Click "Add Media" button  
2. Using the file selection thing, select your PDF and click the upload button.  
3. After it uploads, you'll have this new section that shows the Link URL. You can change 

the name of the URL to appear as you would like on the site.  
4. Click the blue "Update" button on the left hand side. 

 

Checklist of changes to make  
-Change an image/Add an image  
-Change text  
-Make a draft post (A post is an update or announcement you would like to make to the public)  
-Add photos to gallery  
-Add a tab 

 

Wordpress Account: Login to Dashboard for the website  
Username: administration@rmibankingcomm.org  
Password: BCAdmin2016. 

 

Godaddy account:  
Username: rmifiu  
Password: Rmifiu2016  
Pin: 2310 

 

Zoho Emails:  
Username: administration@rmifiu.org  
Password: MajuroBankingAdmin2016. 

 

Incoming Mail Server: pop.zoho.com 

http://www.wordpress.com/
mailto:osa@andrew.cmu.edu
mailto:administration@rmibankingcomm.org
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Outgoing Mail Server: smtp.zoho.com 

Incoming Server (pop3): 995 

Outgoing Server (SMTP): 465 

MojoMarketPlace  
Username: administration@rmibankingcomm.org  
Password: BCAdmin2016. 
 

Bluehost Account 

(Hosting is renewed for 36 months and the next renewal date is on July 05, 2019 and the domain 

renewal date is on July 10, 2019)  
Username: rmibankingcomm.org  
Password: Majurobanking2016. 

 

Emails:  
administration@rmibankingcomm.org  
Password: MajuroBankingAdmin2016. 

 

rjohnny@rmibankingcomm.org  
Temporary Password (please change): Rendy4banking. 

 

Comodo rmifiu.org Certificate  
Revocation password: MajuroBankingAdmin2016 

Expiration Date: 7/25/2019 

 

skorean@rmibankingcomm.org  
Temporary Password (please change): Sultan4banking. 

 

neumi@rmibankingcomm.org  
Temporary Password (please change): Matt4banking. 

 

sleon@rmifiu.org  
Password (already change) 
 
sanien@rmifiu.org 
 

 

Setting up a Zoho email in Outlook (for RMIFIU.org emails)  
https://www.zoho.com/mail/help/outlook-pop-access.html 

 

 

 

 

 

 

 

 

mailto:administration@rmibankingcomm.org
mailto:administration@rmibankingcomm.org
mailto:rjohnny@rmibankingcomm.org
mailto:skorean@rmibankingcomm.org
mailto:neumi@rmibankingcomm.org
mailto:sleon@rmifiu.og
mailto:sanien@rmifiu.org
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Appendix H: Due Diligence Check Table 
 

The DueDiligenceCheck Table in the FIU Database consists of the following fields: 

Date 

Date Received 

Reference Number (Primary Key) 

Requesting Agency 

Entity 

Individual 

Passport Number 

Issuing Country 

Date of Birth 

Notes 
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Appendix I: Banking Commission Account and Renewal Document 

Renew and Install Certificate on Outlook 
Marshall Islands FIU 

 
1. Click the link to install Comodo Email Certificate 
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2. Use Mozilla Firefox (you may have to change your default browser in settings to Firefox) and it will automatically install the 

certificate for you. 

 

 

 



RMI Banking Commission                                                           Page 52 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

 
3. Go to options in Firefox. 
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4. Click on privacy and security. 
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5. Click on view certificates. 
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6. Select the certificate you want to install then click backup. 
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7. Type the file name (ex. Certificate_2018) and select where you will save it. 
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8. Create a backup password for the certificate to protect the backup. 
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9. Now go into outlook and select options. 
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10. Select trust center then trust center settings. 
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11. Select email security. 
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12. Select Import/Export. 
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13. Find and select the certificate you saved on your computer. 
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14. Select settings. 
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15. Select new. 
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16. Choose the signing certificate and the encryption certificate for the new certificate. The signing and encryption certificate 

must be from the same original certificate. 
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17. Select more choices under the certificate and select the new certificate indicated by the date. 
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18. Give the certificate a name, select all the checked boxes, and press OK. 

 

 

 

Appendix J: How to Create a Table in Microsoft Access 2016 
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How to Create a Table in Microsoft Access 2016 

Republic of Marshall Islands FIU 

 
1. Click on the create tab, then the table design button. 
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2. In the table design view click on the first field name and enter the first column heading. 
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3. Select the data type for this field. Most fields will be short text, but some will be currency, date/time, and number. 
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4. You must now indicate the primary key. Click the grey box next to the field name you want to be the primary key, then click the 

primary key button. 

 

The primary key is a unique identifier for each entered report. In the above example the primary key is the CTR ID. 
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5. You can also make a table with multiple primary keys. To do this, click the grey box next to the first primary key, then hold 

control and click the grey box next to the second primary key. 

 

This is called a composite primary key. This means both primary keys cannot be the same for multiple reports. In the above 

example both the CTR ID and SSNorEIN are primary keys. 
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6. Save your table, then hit datasheet view to see the finished table. 

 

 

 

Appendix K: How to create a Form in Microsoft Access 2016 
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How to create a Form in Microsoft Access 2016 

Republic of the Marshall Islands FIU 

 
1. Click on the create tab, then the form wizard button. 
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2. The form wizard box will pop-up. Select the table you want to make the form from (in this case it is the CTR table). 

 

 

 



RMI Banking Commission                                                           Page 76 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

 
3. From the table select the fields you want to have in the form. Use the single arrow on top (>) to select one field. Use the double 

arrow underneath (>>) to select all the fields in the table. Use < and << to deselect fields either individually or all. 
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4. Choose what format you want to have the form in. Orange boxes represent labels and Yellow boxes represent data from the 

corresponding fields. In this instance we want the columnar format. 
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5. Name the form and click finish. 
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6. Here is the result. 

 

 

 

Appendix L: How to create a Report in Microsoft Access 2016 



RMI Banking Commission                                                           Page 80 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

How to create a Report in Microsoft Access 2016 

Republic of Marshall Islands FIU

 
1. Click the create tab, then the report wizard. 
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2. The report wizard will pop-up. Select the table you will use for the report. 
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3. From the table select the fields you want to have in the report. Use the single arrow on top (>) to select one field. Use the double 

arrow underneath (>>) to select all the fields in the table. Use < and << to deselect fields either individually or all. 
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4. You can group the data by fields in this step. On the left side are fields you can group by. The > button will group the form on the 

left side by that field. 
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5. In this example we are grouping the data by date of transaction by each month. Click the field you want to group by and then 

click the > button. The data you are grouping by is indicated in blue on the right side. 
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6. You can change how you group dates by (month, year, quarter, ect.) by clicking the grouping options 
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7. In grouping options you can pick how you group your date.  
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8. You can also sort the data. Indicate which field you want to sort with the drop down menu. Then choose either ascending or 

descending to the right by clicking the button. 
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9. Select the columnar layout. 
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10. Name your report and select modify the report’s design. 
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11. You are now in design view for your report. Select the page break button. 
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12. Place the page break under the last label but before the page footer. 
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13. Right click on the report tab to switch to report view to see how the report looks. 
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14. Right click to switch to print preview to make sure only one report prints per page. 
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Appendix M: New Table Importation Guide 

New Table Importation Guide 
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Marshall Islands FIU 

 
1. Go to External Data -> New Data Source -> From Database -> Access 
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2. Select the backend database you made the table in. Select “Link to the data source by creating a table” 
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3. Select the table you want to import. ONLY SELECT THE NEW TABLE. 

 

 

 

Appendix N: How to Link Back End Tables to Front End Database 
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How to Link Back End Tables to Front End Database 
Marshall Islands FIU

 
1. Go to External Data and click on Linked Table Manager 
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2. Select the tables you want to link to the Front End database then check the box next to Always prompt for new location. 
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3. Select the location of the Back End file you want to link with the Front End Database. 
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4. If the importation is successful you will get this message. 

 

 

Appendix O: Import Tables, Forms, and Reports into Database 
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Import Tables, Forms, and Reports into Database 

Marshall Islands FIU 

 
1. Select External Data -> New Data Source -> From Database -> Access 
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2. Select the file you want to import from. Select the first option to import. 
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3. Select the objects you want to import. 
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4. It will prompt you for a password if the database you are importing from is password protected. 

 

 

 

Appendix P: Common Importation Errors 
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Common Importation Errors 

Marshall Islands FIU 
 

 

 

 

 

 

 

 

 

 

 

1. This error indicates a field name (column name) in the database does not match a field name in the file you are importing. 

Compare the field names in the two documents and correct any column mismatch. 

 

-Correct the field name in the importing file (excel/csv) and import the data. Alert the bank to change the field name so that data 

can be imported directly next time. 
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2. Possible reasons for this error to appear: 

a. Multiple records have the same primary key. Check that each record has a unique primary key. In CTRs it is CTRID, in SARs 

it is SARID, in Person in Transaction it is CTRID and SSN/EIN. 

 

-Alert the bank to make the primary key unique. You should not import the record until it has a unique ID. 

 

b. Fields are not formatted correctly. Each field is formatted for certain input (date, number, text ect.) Check that fields have the 

correct formatting in their cells. 

 

-Correct the error in the importing file, then import the data. If it happens more than once alert the bank to syntax errors. 

 

c. The records have already been entered into the database. Check that you have not entered this data into the database yet. If 

you have you will have multiple records with the same primary key (same as error in a.). 
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Appendix Q: Import a CSV file into Access 

Import a CSV file into Access 
Marshall Islands FIU 

 
1. In the external data tab select New Source Data -> From File -> Text File. 



RMI Banking Commission                                                           Page 109 of 125 

Daisy Nkweteyim Nikolas Rebovich, Student Consultants                                        August 31, 2018 

 
2. Select Delimited. 
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3. Select comma delimiter, check First Row Contains Fields, and Select “ for text qualifier. 
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4. Select the CSV file you want to import from your computer. 
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5. Select which table you are importing the data to. 
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6. Select finish. 
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Appendix R: Import an Excel file into Access 

Import an Excel file into Access 

Marshall Islands FIU 

 
1. From the external data tab select New Data Source -> From File -> Excel. 
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2. Select the Excel file from your computer. 
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3. Select the table you will import the data to. 
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4. Access will automatically check First Row Contains Column Headings. Click next. 
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5. Click finish. 
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Appendix S: CTR Printable Report 
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Appendix T: SAR Printable Report 
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Appendix U: Standard Operating Procedure to Modify FIU 

Database 

 

Standard Operating Procedure to Modify FIU Database 

 

This SOP defines the procedure to follow when modifying tables, forms, or reports in the FIU 

Database 

 

If you are modifying tables or forms: 

 

1. Create a draft form or report in Practice FIU Database (FIU_Practice_Database_2018). 

 

2. Have the draft document approved by the FIU Manager. 

 

3. Have the draft document approved by the Commissioner of Banking. 

 

4. Make sure the primary database (FIU_Database_2018) is only open on the computer where 

the database will be modified. 

 

5. Import form or report from practice database into primary database by using the guide 

“How to Import into Database”. 

 

If you are modifying a table: 

 

1. Create a draft table in Practice FIU Database backend (BCPracticeDatabase_2018_be). 

 

2. Link the table in the FIU Practice Database backend to the FIU Practice Database frontend 

by using the guide “How to link Backend Tables to Frontend Database”. 

 

3. Have the draft table approved by the FIU Manager. 

 

4. Have the draft table approved by the Commissioner of Banking. 

 

5. Make sure the primary database (FIU_Database_2018) is only open on the computer where 

the database will be modified. 

 

6. Make the table in the primary backend database (FIU_Database_2018_be) then link it to 

the primary frontend database (FIU_Database_2018). 

 


